
Managing Faults

This section describes how Prime Central locates, diagnoses, and reports network problems.

Prime Central Fault Management uses a very limited version of the IBMTivoli Netcool/OMNIbus technology.
Some of the windows in the Alarm Browser and Alarm Report portlets have a Help button that launches the
IBM Tivoli Netcool online help. See the Cisco license agreement for the limitations that apply.

Note

This section contains the following topics:

• What Is Fault Management?, on page 1

What Is Fault Management?
Fault management is the process of locating, diagnosing, and reporting network problems. This is important
for increasing network reliability and effectiveness, and for increasing the productivity of network users. Fault
management is more than just handling emergencies. It provides functions for managing problems with
services and handling customer-facing service problems.

Efficient fault management can:

• Save repair costs through efficient fault detection, location, and correction

• Improve customer care through efficient trouble administration

• Improve service availability and equipment reliability through proactive maintenance and through
measurement, review, and corrective action

One responsibility of fault management is to detect faults. A piece of equipment, a transmission medium, a
software module, or a database is said to be in a fault state if it cannot perform its intended function and meet
all of the requirements placed on that function. The onset of a fault is called a failure event and is usually
signaled by one or more alarm reports. The termination of a fault state is called a clear event.

Fault management is responsible for determining, from a variety of information sources, the root cause of a
fault, and for its repair. In certain cases, the root cause of a fault might be in a connecting network. In such
cases, fault management is responsible for reporting the problem through appropriate channels.

The steps for successful fault management are:

1. Identify a problem by gathering data about the state of the network (polling and trap generation).
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2. Restore any services that have been lost.

3. Isolate the cause, and decide if the fault should be managed.

4. Correct the fault.

Fault Management Terminology
In Prime Network, an alarm represents a scenario that involves a fault in the network, a managed element, or
the management system. A ticket represents an attention-worthy root cause alarm. A ticket has the same type
as the root cause alarm it represents, and it has a status, which represents the entire correlation tree.

In Prime Optical, an alarm represents a notification from a managed network element (NE) that a certain fault
condition occurred. Alarms usually represent error conditions on NEs. Prime Optical does not use the term
tickets. NEs managed by Prime Optical perform correlation and suppression and report only root cause alarms.

A ticket in Prime Network represents the same information as an alarm in Prime Optical.

Prime Central Fault Management uses the term alarm to mean a root cause fault condition on which the entire
fault lifecycle can be performed.

Alarm Processing
Prime Network receives events (syslogs and traps) from network elements and performs the first level of
alarm correlation. Prime Central Fault Management receives correlated alarms from Prime Network and
alarms for PrimeOptical and performs second-level, cross-domain alarm correlation and deduplication. Prime
Central Fault Management provides an aggregated view of correlated and deduplicated alarms to network
operation center (NOC) operators.

Prime Central Fault Management does not retrieve alarm data for Prime Provisioning or Cisco InTracer.Note

Prime Central Fault Management:

• Receives alarms from Prime Optical and tickets from Prime Network.

• Receives system alarms and threshold crossing alerts from Prime Performance Manager.

• Normalizes the alarms and tickets to a common alarm representation to perform aggregation, deduplication,
correlation, and enrichment.

• Maintains all active alarms in the Fault Management database. The alarms are also copied from the Fault
Management database to the Oracle database for archiving and historical reporting.

Alarm Aggregation
Alarm aggregation involves the following functions:

• Receive alarms from Prime Optical-Java and CORBA probes use the CORBA northbound interface
(NBI) to get and register for alarms from Prime Optical.

• Receive tickets from Prime Network—SNMP probes use the trap forwarding interface to receive tickets,
ticket updates, and ticket severity updates from Prime Network.
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• Use the Fault Management SNMP probe and the Prime Performance Manager trap forwarding interface
to aggregate Prime Performance Manager alarms.

• Normalize and persist received alarms—Probes perform normalization; the FaultManagement component
persists normalized alarms.

Alarm Deduplication
Prime Optical and Prime Network manage the same CPT devices and generate the same alarm conditions for
CPT managed objects. The following table shows some of the alarm conditions that Prime Optical and Prime
Network generate for the same managed objects, and for which Prime Central Fault Management performs
deduplication.

Table 1: Deduplication of Alarm Conditions

Prime Network Alarm ConditionPrime Optical Alarm Condition

Card downEquipment failure

Card outEquipment unplugged, missing, or removed
incorrectly

Port/link operational/admin downAIS, LOS, LOF on port

The following example illustrates an alarm deduplication:

Prime Optical Alarm

• Probable Cause—LOS.

• Object Name—ONS-SJC/rack=1/shelf=1/slot=3/port=4.

• Node—209.165.202.129.

Prime Network Alarm

• cenAlarmDescription—Port Down Due to Admin.

• cenAlarmManagedObjectClass—{[ManagedElement(Key=ONS-SJC)]
[PhysicalRoot][Chassis][Shelf(ShelfNum=1)] [Slot(SlotNum=3)][Module]
[Port(PortNumber=TenGigabitEthernet1/3/4)][PhysicalLayer]}.

• cenAlarmManagedObjectAddress—209.165.202.129.

Alarm Correlation
Prime Central Fault Management correlates Layer 2 or Layer 3 alarms generated by Prime Network to the
root cause that Prime Optical detects in the dense wavelength-division multiplexing (DWDM) optical layer.
In Prime Central 1.5.2, cross-application correlation is limited to within the same CPT, meaning the root cause
alarm and the correlated alarm are on the same CPT device.

Prime Central Fault Management performs correlation of the alarm conditions listed in the following table
by Prime Optical and Prime Network.
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Table 2: Alarm Correlation

Prime Network AlarmPrime Optical Alarm

cenAlarmManagedObjectClasscenAlarmDescriptionObject Name/ LocationProbable Cause

OID of MPLS-TP LSPMPLS-TP LSP downMPLS-TP enabled uplink
port on CPT

FEC-MISM,OTUK-TIM,
LOM

Alarm Aging
Prime Central Fault Management uses the following alarm aging policy:

• By default, cleared alarms are deleted from the Prime Central Fault Management database after 60
minutes.

• Indeterminate and informational alarms that are not being used for service impact analysis or customer
impact analysis are deleted after 1 day.

• Warning alarms that are not being used for service impact analysis or customer impact analysis are
deleted after 7 days.

• Active alarms that do not meet the preceding criteria persist indefinitely in the database, unless a user
clears them manually.

• The Prime Central database mirrors and archives the Prime Central Fault Management database. When
you delete an alarm from the Prime Central Fault Management database, it is deleted immediately.
However, the Prime Central database retains the deleted alarm for 14 days, and then purges it.

User can configure alarm retention period, to configure please refer Configuring
Alarms Retention Period.

Note

Monitoring Affected Services and Customers
Prime Central provides an Alarm Browser portlet (see the following figure). Users with the Fault Management
role and privileges can use the Alarm Browser to monitor and manage data about faults in the network.
Information about alarms is displayed in the portlet according to filters and views:

• Filters let you display a subset of alerts based on specific criteria.

• Views let you choose which alert fields to display.
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Figure 1: Alarm Browser Portlet
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Opening the Alarm Browser Portlet
To open the Alarm Browser portlet to display aggregated, deduplicated, and correlated active alarms:

Procedure

Step 1 From the Prime Central menu, choose Assure > Prime Central Fault Management > Alarm Browser.

You must have the appropriate role and privileges to open the Alarm Browser. If not, the following message
is displayed:

You do not have access privileges to use the Fault Management component. Contact your

administrator for access.

Step 2 The first time you open the Alarm Browser, you must accept the self-signed, untrusted security certificates.

Mozilla Firefox

To accept the security certificates in Firefox, do the following:

a) At the “This Connection is Untrusted” security prompt, right-click the frame behind the popup message
and choose This Frame > Open Frame in New Tab.

The security certificate opens in a new browser tab.

b) Click I Understand the Risks.
c) Click Add Exception.
d) In the Add Security Exception dialog box, make sure the Permanently store this exception check box

is checked. (If you leave it unchecked, you will have to reaccept the security certificates the next time
you launch the Alarm Browser.) Then, click Confirm Security Exception.

e) Close the new tab, return to the Prime Central portal tab, and click the Refresh Current Page icon.
f) In the Warning - Security dialog box, check the Always trust content from this publisher check box.

(If you leave it unchecked, you will have to reaccept the security certificates the next time you launch the
Alarm Browser.) Then, click Yes to the following message:
The web site’s certificate cannot be verified. Do you want to continue?

If you click No, the security certificate is denied, and the Alarm Browser displays the error The
application failed to run.

Note

Microsoft Internet Explorer 10 and 11

If you have already applied CA Signed Certificates in Internet Explorer 10 or 11, then do not follow
the below mentioned steps.

Note

To accept the security certificates in Internet Explorer, do the following:

a) Open Prime Central Fault Management login window in a new tab by entering the following URL:
http://Fault-Management-server-IP-address:Fault-Management-web-service-listener-port/primefm/console

The Prime Central Fault Management web service listener port is 16311.Note

b) Click Certificate Error in the browser's address bar, the Untrusted Certificate dialog box opens.
c) Click View Certificates and click on Certification Path tab.
d) The Certificate dialog box opens. Select first certificate (root certificate) and click View Certificate.
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e) Click Install Certificate to launch the certificate import wizard.
f) Click Next.
g) Select the Place all certificates in the following store radio button option and then click Browse.
h) Navigate to the Trusted Root Certification Authorities folder and select it.
i) Click OK.
j) Click Next.
k) Click Finish to complete the wizard.

A security warning appears.
l) Click Yes to confirm that you want to install the certificate.

A message appears, indicating that the certificate import was successful.
m) Click OK to close the message.
n) Click OK to close the Certificate dialog box.
o) Close the new tab, return to the Prime Central portal tab, and click the Refresh Current Page icon.

To view Alarm Reports in Internet Explorer 10, perform the following steps:

1. In the Browser window, go to Tools > F12 Developer Tools.

2. Change the Browser Mode to Internet Explorer 9.

3. Change the Document Mode to Internet Explorer 9 standards.

Note

Step 3 (Optional) You can replace the Prime Central certificates with your company’s signed, trusted certificates.
See Managing the Self-Signed Certificates.

Information Displayed in the Alarm Browser Portlet
The Alarm Browser portlet displays the following charts:

• Alarms—Displays in pie chart format the total number of alarms of each severity (critical, major, minor,
and warning) for all applications combined.

• Alarms per Application—Displays in bar chart format the number of critical, major, minor, and warning
alarms for individual applications.

• The vertical axis (y-axis) shows the application.

• The horizontal axis (x-axis) shows the alarm count.

If Prime PerformanceManager is registered with Prime Central and sends alarms
to Prime Central Fault Management, the Alarms per Application chart includes
Prime Performance Manager. If Prime Performance Manager is configured to
send alarms directly to PrimeNetwork, there is no bar chart for Prime Performance
Manager.

Note

The table on the bottom half of the portlet displays the following information by default.
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Table 3: Field Descriptions for the Alarm Browser Portlet

DescriptionField

Severity of the selected alarm:Severity

Critical alarm (red)

Major alarm (orange)

Minor alarm (amber)

Warning alarm (turquoise)

Indeterminate alarm (blue)

Cleared, normal, or OK (green)

Whether the selected alarm has been acknowledged in Prime Central.
Values are Yes or No.

Prime Network changes alarm acknowledge state to
Modified, if a new event is correlated to an acknowledged
ticket. Prime Central GUI shows Yes or No indicating
Acknowledged orUnacknowledged respectively (Modified
state in Prime Central is internally mapped to
Unacknowledged).

Note

Acknowledged

Name of the device where the selected alarm occurred.Element Name

Error message or condition that is associated with the selected alarm.Description

Physical location of the equipment where the selected alarm occurred,
such as chassis, rack, subrack (shelf), slot, and port numbers.

Location

Time stamp when the alarm last occurred.Last Occurrence

Name of the customer affected by the alarm.Customer

Name of the service affected by the alarm.Service

Name of the application where the selected alarm originated.Source

IP address of the device where the selected alarm occurred.Element IP

Name of the VM where the selected alarm occurred.VM Name

Name of the host server where the selected alarm occurred.Host Server Name

Number of times the alarm occurred.Count

Whether the selected alarm has correlated alarms associated with it.Has Correlated

Unique identifier assigned to the selected alarm by the application where
the alarm originated.

EventId
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DescriptionField

Unique identifier assigned to the selected alarm by the FaultManagement
component. Use this value when sending requests via the NBI API.

Serial

The Alarm Browser's right-click menu options provide centralized alarm lifecycle management for the
applications listed in the following table.

For More Information, See...Supported by...Right-Click Menu
Option

—PrimePerformance
Manager

Prime
Optical

Prime
Network

—

Acknowledging or Deacknowledging an
Alarm

YesYesYesAcknowledge

Acknowledging or Deacknowledging an
Alarm

YesYesYesDeacknowledge

Clearing an AlarmYesYes 1YesClear

Retiring an AlarmYesNoYesRetire

Adding Notes to an AlarmYesYesYesAdd to Journal

Resynchronizing ApplicationsYesYesYesResync Domain
Managers

1 Please refer to the Prime Optical 10.0 User Guide for a listing of the alarms that can be cleared.

• If the Alarm Management action you performed is not reflected in the Alarm Browser after refreshing
it, review the Message Center for any errors that may have occurred.

• For Prime Network Tickets, Informational Severity is represented as Indeterminate Severity.

Note

Cross-Application Alarm Management

When configured for Suite Mode, previous releases of Prime Central, Prime Network, Prime Optical, and
Prime Performance Manager supported the following cross-application alarm management tasks from the
Prime Central Fault Management GUI:

• Acknowledge

• Deacknowledge

• Add Notes

• Clear

• Retire

Starting with the latest release of these applications, you can also perform these tasks from Prime Network,
Prime Optical, and Prime Performance Manager (again, when configured for Suite Mode).
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The Retire option is not supported by Prime Optical.Note

In addition, you have the ability to attach a note to any of these tasks from both the Prime Central Fault
Management GUI and NBI. Keep in mind that the applications handle notes differently. Prime Central, Prime
Network, and Prime Optical store the notes and actions associated with an alarm as journal entries, logging
the creation or modification date and the relevant user’s ID for each entry, whereas Prime PerformanceManager
stores a single note that can be modified as often as needed. Here are some other key differences in the way
that the applications handle notes:

• A journal entry with the appropriate action prefix is created for all alarm management tasks performed
from the Prime Central Fault Management GUI or NBI. For example, acknowledging an alarm results
in a journal entry prefixed with Acknowledge_Alarm:.

• A journal entry is not created for any tasks (except for Add Notes) performed from Prime Network, Prime
Optical, or Prime Performance Manager.

• When you add a note to an alarm from Prime Network, Prime Optical, or Prime Performance Manager,
the corresponding journal entry is not prepended with an action prefix.

• In the alarm notifications sent by Prime Optical, there is no way to distinguish between notes generated
in Prime Optical and notes generated in Prime Central. As a result, the journal entries for notes created
in Prime Central for Prime Optical alarms are not prepended with an action prefix.

• Unlike Prime Network and Prime Optical, Prime Performance Manager keeps only one note per alarm.
Prime Central journals each alarmmanagement action (such as acknowledging or clearing an alarm) that
is performed on a Prime Performance Manager alarm, but maintains only one journal entry for each
Prime Performance Manager alarm note. For example, when a note is generated by Prime Performance
Manager, Prime Central creates a journal entry for that same note. If the note is later modified within
Prime Performance Manager, Prime Central overwrites the previous journal entry with the new entry.

Prime Performance Manager sends alarm note updates to Prime Central even if
the updates are generated for alarm management actions carried out in Prime
Central. As a result, it may appear that duplicate notes are listed in the Alarm
Browser journal—this is normal. Prime Central maintains a journal entry for each
alarm management action note it generates and a separate single journal entry
for alarm notes generated by Prime Performance Manager.

Note

For more information on notes, see Adding Notes to an Alarm.

Accessing Additional Alarm Information
From the Alarm Browser portlet, you can access more detailed information for a specific alarm by doing the
following:
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Procedure

Step 1 Right-click an alarm and choose Device Details. Depending on the alarm source, Prime Optical, Prime
Network, or Prime Performance Manager launches, allowing you to view detailed alarm information at the
application level.

• For information about using Prime Network to manage alarms and events, see the Prime Network 4.3.2
Administrator Guide.

• For information about using Prime Optical to view alarm information, see the “Managing Faults” chapter
in the Cisco Prime Optical 10.6 User Guide.

• For information about using Prime PerformanceManager to view alarm information, see the “Managing
Network Alarms and Events” chapter in the Cisco Prime Performance Manager 1.7 User Guide.

Step 2 Right-click an alarm and chooseTicket Details. Prime Network launches and displays additional information
for the ticket associated with the selected alarm. See the "Viewing Ticket Properties" topic in the Cisco Prime
Network 4.3.2 User Guide for a description of the information provided.

This option is available only when you select an alarm that originated in Prime Network.Note

Step 3 Right-click an alarm in the table and choose Common Inventory. The Common Inventory portlet launches,
where you can view detailed information about the device on which the selected alarm occurred. For more
information, see What is Inventory Management?.

Step 4 Right-click an alarm in the table and choose Correlated Alarms to view alarms that are correlated to the
selected alarm.

Prime Central identifies the relationship between a root cause alarm and its consequent alarms. It automatically
correlates the consequent alarms as children of the root alarm. The Alarm Browser displays the root cause
alarm, the aggregated severity of the alarm, and the severity of the root cause alarm. In addition, the Alarm
Browser displays the time at which the original alarm was detected.

Step 5 Right-click a service-impacting alarm in the table and choose SymptomEvents to see which symptom events
are affected by the service-impacting alarm. The filtered view shows the causal relationship between an event
and the consequent events that occurred because of it.

Step 6 Right-click an alarm and choose Subtending Events. The Subtending Events window launches, listing all of
the network events associated with the selected alarm and providing information for those events.

This option is available only when you select an alarm that originated in Prime Network.Note

Step 7 Either double-click an alarm or right-click an alarm and choose Information. The Alarm Status for Serial
Number x dialog opens, showing additional fields that are parsed from the alarm.

Step 8 Right-click an alarm and choose Journal. The Journal Information for Serial Number x dialog opens, listing
all of the notes that have been created for the selected alarm. For more information about notes, see
Cross-Application Alarm Management.

Viewing Alarms in the Alarm Summary
At the bottom of the Prime Central home page, users with the Fault Management role and privileges can view
a summary of the alarm status of the network. Intended as a quick reference, the Alarm Summary shows the
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total number of critical, major, minor, and warning alarms in the network—as do the charts in the Alarm
Browser portlet.

You can change the rate at which the Alarm Summary refreshes automatically. Do the following:

Procedure

Step 1 Click within the Alarm Summary area.
Step 2 In the Alarm Summary Timer dialog box, enter a refresh rate from 10 to 99,999 seconds. The default is 60

seconds.

If you enter a value (such as 10abc) that cannot be parsed as a number, the refresh rate is reset to
the last valid value. If you enter a number less than 10, the refresh rate is set to the lowest minimum,
10 seconds. You cannot enter a value higher than 99,999.

Note

Step 3 Click Update. The Alarm Summary refreshes at the rate you entered.
Step 4 To stop the Alarm Summary from refreshing, reopen the Alarm Summary Timer dialog box and click Stop.

(If later you decide to restart the automatic refresh, click Start.)

If you refresh your web browser, or if you log out of Prime Central and log back in, the Alarm Summary
refresh rate resumes at the default 60 seconds, even if previously you had changed the refresh rate or stopped
it altogether.
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Figure 2: Alarm Summary

Acknowledging or Deacknowledging an Alarm
Acknowledging an alarm indicates that you are aware of the issue and are taking ownership of it. The
acknowledged alarm remains visible in Prime Central.

To acknowledge or deacknowledge alarms within Prime Central and propagate the change back to the
application:

Procedure

Step 1 To acknowledge an alarm, right-click an alarm in the Alarm Browser and choose Acknowledge.
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Step 2 To deacknowledge a previously acknowledged alarm, right-click the alarm and choose De-acknowledge.
Step 3 Refresh the Alarm Browser. The alarm is acknowledged (or deacknowledged) in Prime Central Fault

Management, and the change propagates back to the application.

Clearing an Alarm
Cleared alarms remain in the Prime Central database, but in the Clear state. You clear an alarm when the
condition that caused it no longer exists. A cleared alarms means the alarm should no longer be considered a
problem.

To manually clear an active alarm in Prime Central and propagate the change back to the application:

Procedure

Step 1 Right-click one or more alarms in the Alarm Browser and choose Clear.
Step 2 Refresh the AlarmBrowser. The alarm is cleared in Prime Central Fault Management, and the cleared condition

propagates back to the application.

When you try to clear certain Prime Optical alarms, the Prime Central Message Center might show the
following error message for the clear operation:

API_ERROR:clearAlarm operation failed. Reason: Unable to perform action on alarm IDs -
alarm IDs not found.

If the alarms exist in Prime Optical, you must clear them manually in Prime Optical. For a list of alarm
categories that you must clear manually, see "EMS-Generated Alarms" in the Cisco Prime Optical 10.6 User
Guide, Chapter 9, "Managing Faults."

Retiring an Alarm
To retire a cleared alarm in Prime Central and delete that same alarm from the application:

Procedure

Step 1 Right-click one or more alarms in the Alarm Browser and choose Retire. (Alarms must be cleared before
they can be retired.)

Step 2 At the confirmation prompt, click OK.
Step 3 Refresh the Alarm Browser. The retired alarm is deleted from Prime Central and from the application.

Deleting an alarm from the Fault Management Alarm Browser will not delete the alarm from
corresponding domain managers. It deletes it from only Prime Central and if a resync operation is
done, the alarm re-appears in the Fault Management alarm browser.

Note
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Adding Notes to an Alarm
You can add and save your own alarm history information. You can maintain a journal for any alarm.

To add notes to an alarm and propagate the note back to the application:

Procedure

Step 1 Right-click one or more alarms in the Alarm Browser and choose Add to Journal. The Journal dialog box
opens.

Step 2 Enter a note of up to 4000 characters.
Step 3 Click Save to save the newly entered text and close the dialog box. The alarm note is saved in Prime Central

and propagates back to the application.
Step 4 To view an alarm note in Prime Central:

a) Right-click one or more alarms and choose Journal. The journal shows the alarm note, the name of the
user who entered it, and the date and time of the entry.

b) If you selected multiple alarms in the alarm list, click Previous or Next to move to the alarm note for the
previous or next alarm in your selection.

c) Click Close.

For information on how Prime Central and other Prime applications handle notes, see
Cross-Application Alarm Management.

Note

Resynchronizing Applications
Complete the following procedure to resynchronize the alarm information provided by Prime Central and the
Prime applications associated with it. Before you do so, be aware that:

• This feature is available only for applications that support resynchronization with the Prime Central Fault
Management component.

• To initiate resynchronization from the right-click menu, at least one alarm must be reported in the Alarm
Browser. If no alarms are present, initiate resynchronization by entering the following commands on the
Fault Management server:

su - primeusr

fmctl resync

• Resynchronization status is not indicated in either the Message Center or Audit Log.

Procedure

Step 1 In the Alarm Browser, select an alarm and right-click it to open the right-click menu.
Step 2 Select Resync Domain Managers.
Step 3 To confirm that resynchronization started and completed, enter the following command on the Fault

Management server to view the log file:
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# tail -f ~/faultmgmt/log/resync.log

Sorting Columns
Note the following when you sort columns in the Alarm Browser:

• To sort a column in the Alarm Browser, click the column header once. The rows are sorted in ascending
order.

• To sort in descending order, click the column header again.

• To unsort the column, click the column header a third time.

• To sort multiple columns, press Crtl and click the required column headers. The sorting importance of
the columns is indicated in square brackets ([]) in the column header. To alternate the sorting of individual
columns within the selection between ascending and descending order, keep Ctrl pressed and click the
column headers. To unsort the columns, release Crtl and click any header from among the sorted columns.
The previously sorted columns are unsorted; the column that you clicked is sorted in ascending order.

• To lock a column, right-click the column header and click Lock Column. The column is moved to the
left side of the portlet, and remains visible when you scroll horizontally. To unlock the column, right-click
the column header and click Lock Column again.

Refreshing Data
The alarm list refreshes automatically at regular intervals to show all incoming alerts from the Prime Central
integration layer. You can choose to refresh the alarm list manually between the configured intervals to view
all the latest alerts at the current point in time.

To refresh the Alarm Browser manually between automatic refresh updates, click the Refresh icon in the
toolbar.

Finding Data
Use the Find dialog box to search for specific text within the data in the Alarm Browser by doing the following:

Procedure

Step 1 In the Alarm Browser toolbar, click the Find icon.
Step 2 In the Find dialog box, do the following:

a) In the Column list, select the column to search.
b) In the Value field, enter the search value that you want to match. You can enter an exact value to search

for or a regular expression.
c) In the Options area, specify the type of match required:

• Exact Match—To find rows where the data in the selected column exactly matches the specified
search value.

• Regular Expression—To find rows where the data in the selected column matches the specified
regular expression.
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• Sub String—To find rows where the data in the selected column contains the specified value
somewhere within it.

d) Click Find to find the first matching occurrence.

If a matching row is found in the Alarm Browser, any currently selected rows are deselected, and the
matching row is selected. The Find dialog box remains open so that you can view any additional matching
occurrences.

e) Click Next to show the next match, and subsequent matches, in the Alarm Browser.
f) Click Close to close the Find dialog box.

Changing the Alarm Information Displayed
You can set what alarm information is displayed from the available data by editing the list view, or by selecting
and applying a different view. You can also edit the filter criteria used by the current alarm list, or select a
different filter to apply to the alarm list.

From the Alarm Browser, do any of the following:

• To select a different view to apply to the alarm list, click the View drop-down list on the toolbar and
select from the list of available views.

• To edit the current view and change the columns displayed, click Edit Views. The View Builder opens,
which you can use to edit the view. See Creating and Editing Views.

• To select a different filter to apply to the alarm list, select an available filter from the Filter list.

For example, from the Filter list, choose Service Impact Alarms to view which customers and services
are impacted by a specific alarm.

• To edit the current filter, click Edit Filters. The Filter Builder opens. See Filtering Alarms Using the
Advanced Filter.

Filtering Alarms Using the Quick Filter
You can use the quick filtering facility as a fast way of displaying alarms that match a selected criteria. You
can filter for alarm data and display alarms that correspond to the value of a specific cell. For example, you
can quickly display only those alarms that occurred at the same time as the selected alarm, or before the
selected alarm.

To filter alarms using the quick filter:

Procedure

Step 1 In the Alarm Browser portlet, right-click a cell that contains a value on which to base the quick filter.
Step 2 From the right-click menu, choose Quick Filter and select a submenu option.
Step 3 To remove quick filtering and restore the portlet to its original view of all alarms, right-click a cell again and

choose Quick Filter > Off.

Managing Faults
17

Managing Faults
Changing the Alarm Information Displayed



Filtering Alarms Using the Advanced Filter
Network alarms typically create many alerts that are not of immediate importance to the personnel monitoring
the system. Use advanced filters to control the alarm information that is displayed.

In the Alarm Browser, use the Filter drop-down list to filter alarm data by specific fields, such as Cleared
Alarms.

To create and edit advanced filters for alarm data:

At the time of Disaster Recovery (DR) configuration, you should create the views manually in the Standby
machine.

Note

Procedure

Step 1 In the Alarm Browser toolbar, click the Edit Filters icon. The Filter Builder opens.
Step 2 Do one of the following:

• To create a filter, click New Filter.

• To edit an existing filter, select the list that contains the required filter. After the list has refreshed, click
the filter.

If you are editing an existing filter, skip Step 3.

Do not delete the “Default” filter. Deleting the Default filter generates an error.Caution

Step 3 Select the users to whom you want to grant access to the filter, and click OK.
Step 4 Specify the general properties for the filter:

• Name—Enter a name for the filter. The name cannot contain the following characters:

$ ! £ % ^ & * ( ) + = ¬ ` ~ # @ ’ : ; < > { } [ ] ? / \ | , "

Note that you cannot change the name of a filter after you have created that filter.

• Default View—Select the view with which you want to associate the filter, or select the view that is
associated with the filter. The default view is applied when you launch an Alarm Browser with the filter
but do not specify a view.

• Collection—(For global filters and system filters only) Select the filter collection or collections to which
you want to add the filter.

• Description—Enter a description that explains the purpose of the filter.

• Data Source—Select the data source or data sources that contain the fields against which you want to
run queries. Click the Show Data Sources icon to display a list of available data sources.

If you are editing an existing filter, proceed to Step 8.

Step 5 In the first row of the Basic tab, create a filter condition as follows:
a) From the Field list, select a field from the specified data source.
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b) From the Comparator list, select a comparator.
c) In the Value field, enter a numeric data type value, or a string data type value. The data types must

correspond to those in the ObjectServer field. String data type entries in the Value field must be contained
in single quotes.

d) (Optional) Use the “like” and “not like” comparators for regular expression pattern-matchingmetacharacters
against the entry in the Value field.

Do not use the getdate expression in the Value field.Note

Step 6 To add additional filter conditions, click +. You can add as many filter conditions as required.
Step 7 Use the match options to specify how the filter conditions combine in aggregate:

• Click All to trigger the filter only if all the conditions are met.

• Click Any to trigger the filter if any of the conditions are met.

Step 8 (Optional) To preview the literal SQL WHERE clause output, click Advanced.
Step 9 ClickMetric and use the following fields to set the metric value:

• Label—Enter a title for the metric.

• Function—Select a function to perform on the field data.

• Field—Select a field on which to perform the chosen function.

Step 10 Click Save and Close.

Filter Builder Modes

You can use the following modes to create filters; the Filter Builder displays a tab for each mode after you
click New Filter.

Basic Mode

Basic mode provides a set of lists and text fields that you use to specify the filter conditions. To build the
conditions, select a field from the specified data sources, select a comparator, and enter a numeric data type
or string data type value. The data type value is used as the filtering criterion used against the field. If you use
basic mode to construct your filter, you can view the resulting SQL in the text field on the Advanced tab.

The fields in the Basic tab map to the following columns in the Alarm Browser default view:

... Maps to this Alarm Browser column title:This field name:

SeveritySeverity

AcknowledgedAcknowledged

Element IPNode

Element NameNodeAlias

DescriptionSummary

LocationAlertKey
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... Maps to this Alarm Browser column title:This field name:

Last OccurrenceLastOccurrence

CountTally

SourceAgent

CustomerCustomer

Has CorrelatedHasCorrelated

Advanced Mode

Provides a text field into which you can enter an SQL syntax. If you create a filter in advanced mode, it might
not be possible to express the SQL syntax in the fields on the Basic tab. After you have saved a filter created
in advanced mode, the Basic tab is removed for that filter.

Dependent Mode

This tab is displayed only for dependent filters. On this tab, use the Search fields to identify the filters that
you want to use for the dependencies. After you have identified the required filters, move the filters from the
Available filters list to the Selected dependencies list. In a dependent filter, the SQL WHERE statements of
each filter are concatenated by using OR statements.

Metric Mode

A metric is an aggregate statistic that can be derived from the alerts that match a filter to display a useful
figure; for example, an average, count, or sum of all field values. If a filter is displayed using a monitor box
linked to an Alarm Browser, the metric information obtained from the set of alerts that match this filter is
used for this display.

Creating and Editing Views
Use the View Builder to create and edit views that are dynamically applied to Alarm Browser data. The views
determine what information is displayed from the available alarm data.

At the time of Disaster Recovery (DR) configuration, you should create the views manually in the Standby
machine.

Note

Procedure

Step 1 In the Alarm Browser toolbar, click the Edit Views icon.
Step 2 In the View Builder, do one of the following:

• To create a new view, click New View.

• To edit an existing view, select the desired view from the View list. The page updates with the view
properties.
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If you are editing an existing view, skip Step 3.

Step 3 Select the users to whom you want to grant access to the view, and click OK.
Step 4 Use the following fields to set the general properties for the view:

• Name—Enter a name for the view. The name cannot contain the following characters:

$ ! £ % ^ & * ( ) + = ¬ ` ~ # @ ’ : ; < > { } [ ] ? / \ | , "

By default, the following characters cannot be used as the initial character of a view name:

/ \ * ? " < > | & .

• Data Source—Select the data source or data sources that contain the fields that you want to be displayed
in the view. Click the Show Data Sources icon to display a list of available data sources.

Step 5 Select the columns you want the Alarm Browser to display, and specify how those columns are ordered.
a) In the Display Columns area, use the > and < arrows to move fields between lists. Only those fields in

the Event list view list are visible as columns in the Alarm Browser.
b) In the Event list view list, select a field.
c) Use the arrow buttons to the right of the list to change the display order of the columns in the view:

• Click Top to move the field to the top of the list. In the Alarm Browser, the field is displayed as the
column furthest to the left.

• Click Up to move the selected field up one position in the list.

• Click Down to move the selected field down one position in the list.

• Click Bottom to move the selected field to the bottom of the list. In the Alarm Browser, the field is
displayed as the column furthest to the right.

d) (Optional) Check the Lock column check box to lock the selected column at the far left of the Alarm
Browser in the view, so that the column is always displayed when you scroll horizontally.

e) (Optional) Select a field from the Event list view list and update the corresponding column’s title, width,
and alignment.

Step 6 Click Save and Close.

Freezing and Unfreezing the Alarm Browser
To take a snapshot of alarm information before it is changed by updates from the Prime Central integration
layer, you can freeze all the fields on the Alarm Browser by doing the following:

Procedure

Step 1 To freeze the fields, click the Freeze/Unfreeze icon in the Alarm Browser toolbar.

The updates from the Prime Central integration layer are suppressed.

Step 2 To unfreeze the fields and obtain updates from the Prime Central integration layer, click the Freeze/Unfreeze
icon again.
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Step 3 (Optional) To force a refresh of the fields independently of the refresh rate, click the Refresh icon.

Configuring Email and SMS for Alarm Notifications
You can configure Prime Central Fault Management to notify you whenever a critical or major alarm is
generated. You can choose to receive either an email notification or a SMS notification sent to your cell phone.

Prime Central Fault Management uses the Linux sendmail function under /usr/sbin, /sbin, /usr/lib, /bin, or
/usr/bin to send email notification.

Note

Procedure

Step 1 As the primeusr user, log in to the Prime Central portal with the primeusr password that you specified during
installation.

Step 2 Change directories to the installation-directory/faultmgmt folder.
Step 3 Open the .primefmmaillist file and add both the email addresses and phone numbers that you want to receive

alarm notifications.
You can enter multiple email addresses and phone numbers on a single line, separated by a space. Entries for
SMS message recipients should be formatted as follows:

recipient’s-mobile-number@carrier’s-SMS-gateway-address

To determine a carrier’s SMS gateway address, either view this page or contact the carrier directly.Note

Step 4 Save and close the .primefmmaillist file.

When a critical or major alarm occurs, you will receive an email or SMS message similar to the following:
From: PRIMEFM User [mailto:primeusr@cisco.com]
Sent: Monday, February 17, 2014 7:21 AM
To: John Doe
Subject: Prime Central Fault Management Email
This message refers to node <node-ID>, which has the following problem:
Loss of communication

The severity is Critical
Sent by Cisco Prime Central Fault Management

Ensure the sendmail and m4 packages are installed. You can install the sendmail and m4 packages
using the following commands as root user:

Note

# yum install sendmail sendmail-cf

# yum install m4
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Changing Alarm Browser Preferences

Procedure

Step 1 In the Alarm Browser toolbar, click the Change preferences icon.
Step 2 In the Preferences dialog box, click theMonitor Boxes tab and specify what information is displayed by the

monitor boxes on the Alarm Browser.

See Preferences Dialog Box, on page 23 for a description of the options you can set in the Preferences dialog
box.

Step 3 Click the Notifications tab and configure preferences for alert notifications when the alarm list is minimized.
Step 4 Click the Flashing tab and specify alarm list preferences for flashing on receipt of new alerts.
Step 5 Click the Event List tab and set other alarm list preferences.
Step 6 Click Apply.
Step 7 Click Save; then, click Close.

Preferences Dialog Box

The following table describes the options you can set in the Alarm Browser’s Preferences dialog box.

Table 4: Preferences Dialog Box

DescriptionOption

Monitor Boxes Tab

Displays the number of alerts that match the filter.Show Number of Alerts

Displays the highest severity of the alerts that match the filter.Show Highest Severity

Displays the lowest severity of the alerts that match the filter.Show Lowest Severity

Displays a border around the monitor box in the color of the highest-severity
alert that matches the filter.

Show Highest Severity Border

Displays the selected filter metric value.Show Metric

(Applicable only if you selected the ShowHighest Severity option) Displays
the highest-severity alert indicator in the color of the alert: for example, in
red if the highest-severity alert is critical.

Show Highest Color

(Applicable only if you selected the Show Lowest Severity option) Displays
the lowest-severity alert indicator in the color of the alert.

Show Lowest Color

Choose the font and the font size for the text on the monitor boxes.Font
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DescriptionOption

Specify the format for the distribution meter:

• Show Lava Lamp—Displays the distribution meter as a series of
horizontal bars.

• Show Histogram—Displays the distribution meter as a bar graph.

• Show None—Switches off the distribution meter.

Distribution meter

Notifications Tab

Check this check box to receive notification of new, changed, or deleted
alerts when the alarm list is minimized.

Enabled

Click this radio button to receive notification of new, changed, or deleted
alerts on iconized desktop environments. An iconized desktop environment
displays an icon when the alarm list is minimized.

When Iconized

Click this radio button to always receive notification of new, changed, or
deleted alerts.

Always

Check each check box to receive notification as follows:

• New—You receive a notification when a new alert is added to the
alarm list.

• Change—You receive a notification when an existing alert changes in
the alarm list.

• Delete—You receive a notification when an existing alert is deleted
from the alarm list.

When

Select each option to indicate how a notification should occur:

• Alert Icon—Flashes the minimized alarm list.

• Open Window—Opens the alarm list on the window.

• Play Sound—Plays a sound on the workstation.

• Open URL—Opens a URL. In the URL Target field, enter the URL
that you want to be opened.

How

Flashing Tab

Check to enable alarm list flashing.Enable Flashing check box

Use to indicate how quickly the alarm list flashes.Speed slider

Use to indicate the degree of brightness of the flashing.Brightness slider

Event List Tab

Displays each row of the alarm list with a background color that corresponds
to the severity of the alarm.

Show Colors
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DescriptionOption

Displays the distribution summary bar, which shows the number of alerts
that match each severity color.

Show Distribution Summary
Bar

Makes the toolbar available on the alarm list.Show Toolbar

Choose a font for your alarm list.Font Name

Choose a font size for your alarm list.Font Size

Choose the required date format. If you select Customize, enter a custom
format.

Date Format

Choose a time zone from the available options.Time Zone

Specify how you want the alarm severity to be depicted in the Severity
column:

• Show—Displays an icon to denote alarm severity.

• Show With Text—Displays an icon and text to denote alarm severity.

• Don’t Show—Displays text to denote alarm severity.

Event List Icons

Customizing the Sound of Alarm Notifications

To set up the Play Sound option for audible notification:

Procedure

Step 1 Prepare the sound file and place it in the following directory on your server:
Fault-Management-installation-directory/faultmgmt/
tipv2/profiles/TIPProfile/installedApps/TIPCell/isc.ear/OMNIbusWebGUI.war/sounds.

Step 2 In the Alarm Browser toolbar, click the Change preferences icon.
Step 3 In the Notification area, check the Enabled check box.
Step 4 In the Preferences dialog box, click the Notifications tab.
Step 5 In the How area, check the Play Sound check box.

To preview the default sound, click the Play button.Tip

Step 6 To change the default sound to the one you uploaded in Step 1, specify the sound file in the Play Sound field.
Use the following format:

$(SERVER)/sounds/<sound-filename>

For example:

$(SERVER)/sounds/crash.wav

Step 7 Click Apply.
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Step 8 Click Save; then, click Close. The change takes effect when a new notification appears.

Managing Prime Central Fault Sources
From the Fault Source Management portlet, you can identify and keep tabs on the sources from which Prime
Central gathers your network’s alarm and trap information. To view this portlet:

1. Ensure that you have have fault management privileges.

2. Add it to the Prime Central home page. See Adding a Portlet for instructions.

Note the following:

• After a source has been registered with Prime Central’s fault management component, fault data for that
source is displayed in the Alarm Browser portlet.

• All instances of Prime Network, Prime Optical, and Prime Performance Manager associated with Prime
Central are automatically added to the Fault Source Management portlet. Also, these are the only fault
sources that cannot be modified or removed from the portlet.

Adding a Fault Source

Procedure

Step 1 From the Fault Source Management portlet, click Add.

The Add New Fault Source dialog box appears.

Step 2 Enter the appropriate information and then click OK.

Note the following:

• A red asterisk denotes the fields that require user input.

• If you select the Resync Support check box, you will need to enter additional information.

See the Add New Fault Source Dialog Box for a description of the fields provided here.

Editing a Fault Source

Procedure

Step 1 From the Fault Source Management portlet, select the fault source you want to modify and then click Edit.

The Edit Fault Source dialog box appears.

Step 2 Make the necessary changes and then click OK.

You can edit everything except the source type.Note
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See the Add New Fault Source Dialog Box for a description of the fields provided here.

Deleting a Fault Source

Procedure

Step 1 From the Fault Source Management portlet, select the fault source you want to remove.
Step 2 Click Delete.

Add New Fault Source Dialog Box
The following table describes the fields that are provided in this dialog box.

DescriptionField

Indicates the fault source type.Type

Display name of the fault source, which is listed in the Fault Source Management
portlet’s Source column.

Display Name

Hostname of the fault source.Host Name

Instance name of the fault source.Instance Name

Description of the fault source.(Optional) Description

Version number of the fault source.Version

Patch number of the fault source.(Optional) Patch

Indicates whether resync is enabled on the fault source.

When this option is selected, the data for a particular fault source is automatically
synchronized whenever you restart Fault Management.

Resync Support

URL of the fault source on which resync is enabled.Resync URL

Username required to log in to the fault source.User Name

Password required to log in to the fault source.Password

Analyzing Fault Data
Prime Central provides an Alarm Report portlet (see the following figure) that lets you analyze fault data and
help you make informed and timely decisions. Reports can be published to the portlet to ensure that everyone
in your organization has accurate and relevant information when they need it.
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The Alarm Report portlet shows an alarm summary and details grouped by node, severity, source application,
and so on. Users with the appropriate role and privileges can view, customize, and schedule reports for active
and historical alarms. You can export the generated reports in HTML, PDF, Excel, and PostScript format.

The Alarm Report portlet displays the following tabs:

• Public Folders—Reports that are placed in Public Folders are of interest to and can be viewed by many
users.

• My Folders—You create personal folders and use them to organize reports according to your preferences.
My Folders are accessible by you only when you are logged on.

Figure 3: Alarm Report Portlet

Set Properties icon6Predefined alarm reports1

Launch menu7Public Folders tab2

Order icon8My Folders tab3

More link9Refresh icon4

——Delete icon5

Report Studio is not supported in Prime Central 1.4. Also, the links under Launch menu are not supported.Note

Default Alarm Reports
The Alarm Report portlet supports the predefined alarm reports shown in the following table.
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Table 5: Default Alarm Reports

PurposeDescriptionReport Name

Average Acknowledgment

Assists operators and managers in
pinpointing and addressing discrepancies
in acknowledgment rates across the
network.

Shows a detailed breakdown of the average
acknowledgment times within a network
management environment for a specific
user or group.

Ack_Events_Details

Shows the average acknowledgment times
within a networkmanagement environment
for all users and groups.

Ack_Events_Summary

Events

Assists operators and managers in
providing coverage for specific criteria in
event management.

Displays a detailed report of all events of
a selected node, class, manager, alert
group, or severity over a user-specified
time period.

Events_Details

Helps identify low performance of a
system or server over a period of time.

Displays the highest event-generating
elements based on either node, class,
manager, alert group, or severity over a
user-specified time period.

Events_Summary

Performance

Helps identify the most overloaded owner,
class, or event manager, and assists in
identifying performance issues.

Generates a supplementary drill-down
report of a selected operator, group, class,
or manager over a user-specified time
period.

Perf_Details

Generates a bar chart and supplementary
drill-down table displaying the number of
events handled by either an owner, class,
or manager over a user-specified time
period.

Perf_Summary

Summary

Allows users to track journal or state
change information about specific nodes
and devices that have generated events.

Retrieves all journal entries associatedwith
a specific node.

Get_All_Journals

Opening the Alarm Report Portlet

If multiple users plan to share the same browser instance and use the Alarm Report portlet, it is recommended
that those users clear their browser cache before logging in to Prime Central.

Tip

To open the Alarm Report portlet:
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Procedure

Step 1 From the Prime Central menu, choose Assure > Prime Central Fault Management > Alarm Report.

If you do not have the appropriate role and privileges to open the Alarm Report, the following message is
displayed:

You do not have access privileges to use the Fault Management component. Contact your

administrator for access.

Step 2 The first time you open the Alarm Report, you must accept the self-signed, untrusted security certificates.

Mozilla Firefox

To accept the security certificates in Firefox, do the following:

a) At the “This Connection is Untrusted” security prompt, right-click the frame behind the popup message
and choose This Frame > Open Frame in New Tab.

The security certificate opens in a new browser tab.

b) Click I Understand the Risks.
c) Click Add Exception.
d) In the Add Security Exception dialog box, make sure the Permanently store this exception check box

is checked. (If you leave it unchecked, you will have to reaccept the security certificates the next time
you launch the Alarm Report.) Then, click Confirm Security Exception.

e) Close the new tab, return to the Prime Central portal tab, and click the Refresh Current Page icon.
f) In the Warning - Security dialog box, check the Always trust content from this publisher check box.

(If you leave it unchecked, you will have to reaccept the security certificates the next time you launch the
Alarm Report.) Then, click Yes to the following message:

The web site’s certificate cannot be verified. Do you want to continue?

If you click No, the security certificate is denied, and the Alarm Report displays the error “The
application failed to run.”

Note

Microsoft Internet Explorer

To accept the security certificates in Internet Explorer, do the following:

a) At the security prompt, click Continue to this website.
b) In the Internet Explorer Information Bar, choose Display Blocked Content.
c) In the Warning - Security dialog box, check the Always trust content from this publisher check box.

(If you leave it unchecked, you will have to reaccept the security certificates the next time you launch the
Alarm Report.) Then, click Yes to the following message:

The web site’s certificate cannot be verified. Do you want to continue?

If you click No, the security certificate is denied, and the Alarm Report displays the error “The
application failed to run.”

Note

Step 3 (Optional) You can replace the Prime Central certificates with your company’s signed, trusted certificates.
See Managing the Self Signed Certificates.
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Creating a New Report

Procedure

Step 1 In the Alarm Report portlet, click Launch > Report Studio.

Report Studio is a web product for creating reports that analyze corporate data according to specific information
needs.

Step 2 Click Create a new report or template.
Step 3 Choose the desired report template; then, click OK.
Step 4 Select the data items you want to appear in your report:

a) In the Insertable Objects pane, on the Toolbox tab, drag Singleton to the report.

An empty data container is created.

b) From the Insertable Objects pane, on the Source tab, drag a data item into the singleton container. To
create a singleton, you can also drag a data item anywhere in your report layout.

c) To change the query associated to the singleton object, in the Properties pane, double-click the Query
property and make changes.

Step 5 From the Run menu, click one of the options to produce the report in the format you want.

You can produce a report in HTML, PDF, CSV, various Excel formats, and XML. You cannot produce a
report in CSV format if you have more than one query defined in the report unless the additional queries are
used for prompts.

The report runs. Once the report has finished running, you can run the report again in the same format or in
a different format. If you run the report again in CSV or XLS format, the report will appear in a new browser
window.

Scheduling a Report
You can set up a schedule to run a report at a later time or at a recurring date and time.

If you no longer need a schedule, you can delete it. You can also disable it without losing any scheduling
details. You can then enable the schedule at a later time.

Procedure

Step 1 Drill down to the report for which you want to set up a schedule; for example, Public Folders > Alarm
Reports > Events > Events_Details.

Step 2 Click the Schedule - report name icon.
Step 3 Specify the schedule parameters:

• Under Priority, lower numbers designate higher priority. The default priority setting is 3.

• To create the schedule but not apply it right away, check the Disable the schedule check box. To enable
it later, uncheck the check box.
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Step 4 Click OK.

A schedule is created and the report runs at the next scheduled time.

Step 5 After clicking OK, you might receive the following “Renew the credentials” prompt:

The user or password you provided is not valid. Provide valid credentials.

If you enter the password you used to log in to Prime Central and clickOK, the dialog box remains open, and
the password field becomes blank. If you click OK without entering a password, or if you click Cancel, the
dialog box closes, but the scheduled report fails to run because of a password authentication failure.

Do the following:

1. As the primeusr user, log in to the Prime Central Fault Management server.

2. Change directories to the faultmgmt/prime_integrator/scripts/ directory.

3. Run the updatePasswdForReporting.sh script, which lets you provide the username and password to use
for report scheduling.

For example, enter:

# updatePasswdForReporting.sh centraladmin Admin

where:

• centraladmin is the username to use when scheduling a report.

• Admin is the password to use when scheduling a report.

4. Return to the “Renew the credentials” prompt and in the Password field, enter the password you configured
in the previous step; then, click OK.

A schedule is created and the report runs at the next scheduled time.

Step 6 The next time you schedule a report, you do not have to rerun the updatePasswdForReporting.sh script or
renew your credentials. However, if someone else runs the script and changes the report scheduling password,
you must renew your credentials again. To do this:
a) In the Alarm Report portlet, click theMy Area icon and then chooseMy Preferences.
b) In the Set preferences dialog box, click the Personal tab.
c) Scroll down to the Credentials area and click Renew the credentials.

A message appears, indicating that the credentials have been renewed with your username and password.

d) Click OK.

Saving or Emailing a Report
You can distribute reports to other users by:

• Saving them where other users can access the reports at their convenience, such as in the public folders.
Public folders typically contain reports that are of interest to many users.

• Sending them to users by email. This is especially useful if you want to share the report with a group of
people who do not have access to the Alarm Report portlet.
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To save or email a report:

Procedure

Step 1 Open the report that you want to save or email; for example, Public Folders > Alarm Reports > Average
Acknowledgement > Ack_Events_Summary.

Step 2 To save the report:
a) In the report toolbar, choose Keep this version > Save as Report View.
b) Enter a name for the report.
c) Accept the default location, or click Select another location.
d) Click OK.

Step 3 To email the report:
a) In the report toolbar, choose Keep this version > Email Report.
b) Enter the recipient’s email address.
c) Check the following check boxes:

• Include a link to the report—To include a URL to the report in the email.

• Attach the report—To attach the report to the email.

d) Click OK.

Setting Report Properties
You can control the way a report appears and behaves by modifying its properties. To do so:

Procedure

Step 1 Drill down to the report for which you want to set properties; for example, Public Folders >AlarmReports >
Events > Events_Summary.

Step 2 In the report’s Actions toolbar, click Set properties - report name.
Step 3 Click the General tab and make any necessary changes to settings such as the report’s owner, display icon,

and name.
Step 4 Click the Report tab and set the default action that is taken on the report.
Step 5 Click the Permissions tab and specify which users and groups have access to the report, as well as the actions

they can perform on the content.
Step 6 Click OK.

Specifying the Report Order
You can specify the order of reports in the Alarm Report portlet. You might decide to organize reports by
level of usage and place reports that you use daily at the top of the list.
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By default, existing reports are sorted alphabetically. Reports added after the order is specified are shown at
the end of the list.

Procedure

Step 1 In the Alarm Report toolbar, click Order.
Step 2 Select the reports in the “Shown in default order” list box and click the right-arrow button to move them to

the “Shown first” list box.
Step 3 Click the Up, Down, To top, and To bottom links to move the reports within the list.
Step 4 Click OK.

Deleting a Report

Procedure

Step 1 Drill down to the report that you want to delete; for example,Public Folders >AlarmReports > Summary >
Get_All_Journals.

Step 2 Check the check box to the left of the report.
Step 3 In the toolbar, click Delete.
Step 4 At the confirmation prompt, click OK.

Configuring Alarms Retention Period
To retain the historical alarms data for more than 14 days (which is the default period), configure the retention
period usingOptions section inAlarms Report portlet. After the configuration details are saved, the scheduler
is triggered periodically to remove the historical data, which is older than the configured retention period.

• By default, the historical alarms report data is retained for 14 days.

• Increasing alarm retention period will consume more database resources.

• The historical data can be retained to any number of days. But, more than 90 days of retention period
may lead to performance issues.

Note

Procedure

Step 1 In the Alarms Report portlet, at the top right corner, click Options and choose Configuration.
Step 2 Click Edit.
Step 3 Specify the retention period and click Save.
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The allowed retention period range is 1-99999.

Configuring the SNMP Gateway for NBI Integration

Procedure

Step 1 As the primeusr user, log in to the Prime Central Fault Management server.
Step 2 Copy the example properties file, NCO_GATE.props, from the $OMNIHOME/gates/snmp directory to the

$OMNIHOME/etc directory.
Step 3 In the NCO_GATE.props file, change the values of the gateway-specific properties to suit your operating

environment. The gateway-specific properties are listed in the following table:

A new name has been introduced for SNMP gateway process in which is to change the value of
the property "Name" as 'G_SNMP'.

Note

Step 4 Enter the following command to start the SNMP gateway:

nco_g_snmp &

Gateway-Specific Properties
The following table lists the properties you canmodify when configuring an SNMP gateway for NBI integration.

Table 6: Gateway-Specific Properties

DescriptionCommand-Line
Option

Property Name

Community string from SNMP traps. The default is public.-snmpcommunity
string

Gate.SNMP.Community
string

Whether or not host lookup is enabled. The default is TRUE.-snmpenablelookup
boolean

Gate.SNMP.EnableLookup
boolean

Gateway engine ID, which identifies the gateway as the source
of the SNMPv3 traps. The default is 0x0102030405.

This property is used only with SNMPv3 traps and
must match the engine ID specified in the
configuration file of the receiver.

Note

-snmpengineid
string

Gate.SNMP.EngineID
string

Whether or not the gateway forwards alert updates to the
ObjectServer. In effect, the original alert is duplicated but will
include the updated data. The default is FALSE.

-snmpforwardupdates
boolean

Gate.SNMP.ForwardUpdates
boolean

Managing Faults
35

Managing Faults
Configuring the SNMP Gateway for NBI Integration



DescriptionCommand-Line
Option

Property Name

IP address and port to which the gateway forwards traps. The
default is 127.0.0.1:162.

If you are operating in an IPv4 environment, specify the location
in IPv4 format as address:port. For example:

127.0.0.1:8080

If you are operating in an IPv6 environment, specify the location
in IPv6 format, preceded by tcp6 or udp6, and followed by the
port number, as tcp6|udp6:address:port. For example:

tcp6:[::01]:6666

-snmpgateway stringGate.SNMP.Gateway
string

Object identifier (OID) for traps. The default is 1.3.6.1.4.1.1279
(an IANA-registered Private Enterprise Number).

This property can also be defined as @NodeGroup to forward
the value of the NodeGroup column in the status table.

-snmpoid stringGate.SNMP.OID
string

Transport protocol that the gateway uses:

• TCP—Transmission Control Protocol.

• UDP—(Default) User Datagram Protocol.

Store-and-forward mode is not available when
the gateway uses UDP.

Note

-snmpprotocol stringGate.SNMP.Protocol
string

Number of times that the gateway attempts to retry sending a
message on failure. When this number is exceeded, the gateway
stops sending messages to the port. The default is 5.

-snmpretries integerGate.SNMP.Retries
integer

Security level that the gateway uses for SNMPv3 messages:

• AuthnoPriv—The gateway sends the username and
password in encrypted format.

• AuthPriv—The gateway transmits the SNMP traps in
encrypted format.

• noAuthnoPriv—(Default) The gateway does not encrypt
the username, password, or SNMP traps.

This property is used only with SNMPv3 traps.Note

-snmpsecuritylevel
string

Gate.SNMP.SecurityLevel
string

Security name for the gateway as defined in the configuration
file of the receiver. The default is netcool.

This property is used only with SNMPv3 traps.Note

-snmpsecurityname
string

Gate.SNMP.SecurityName
string
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DescriptionCommand-Line
Option

Property Name

Authentication protocol that the gateway uses:

• MD5—(Default) Message Digest 5 protocol.

This property is used only with SNMPv3 traps.Note

-snmpsecurityauthprotocol
string

Gate.SNMP.Security
AuthProtocol string

Privacy protocol that the gateway uses to encrypt data:

• AES—Advanced Encryption Standard.

• DES—(Default) Data Encryption Standard.

-snmpsecurityprivprotocol
string

Gate.SNMP.Security
PrivProtocol string

Password used for authentication. The default is password.

The password must be at least eight characters long.
This property is used only with SNMPv3 traps.

Note

-snmpsecurityauthpassphrase
string

Gate.SNMP.Security
AuthPassphrase
string

Password used for privacy. The default is password.

This property is used only with SNMPv3 traps.Note

-snmpsecuritypriv
passphrase string

Gate.SNMP.Security
PrivPassphrase
string

Version of the SNMP writer. The default is 2.-snmpsnmpversion
integer

Gate.SNMP.SNMPVersion
integer

Trap type value for the specific trap field in forwarded SNMP
traps. The default is 1.

This property can also be defined as @Class to
forward the value of the Class column in the
alerts.status table.

Note

-snmpspecific
integer

Gate.SNMP.Specific
integer

Whether or not the gateway runs in store-and-forwardmode. The
default is FALSE.

Store-and-forward mode is not available when the
gateway uses UDP.

Note

-snmpstoreandforward
boolean

Gate.SNMP.Store
AndForward
boolean

Name and location of the storage file that the gateway uses when
operating in store-and-forward mode. The default is
$OMNIHOME/var/NCO_GATE_snmp_.store.

-snmpstorefile stringGate.SNMP.StoreFile
string

Time (in seconds) that the gateway waits for a connection from
an SNMP receiver before timing out. The default is 600.

This property is used only when the
Gate.SNMP.Protocol property is set to TCP.

Note

-snmptimeout
integer

Gate.SNMP.Timeout
integer
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DescriptionCommand-Line
Option

Property Name

Trap type value of the generic trap field in forwarded SNMP
traps.

This property can also be defined as @Severity to
forward the value of the Severity column in the
alerts.status table.

Note

-snmptrap integerGate.SNMP.Trap
integer

Map Definition Files
Map definition files define how the gateway maps data from the SNMP gateway to the status tables in the
Fault Management database. The default map definition file is $OMNIHOME/gates/snmp/snmp.map.

When an event is received, it is converted to the trap format defined in the CISCO-EPM-NOTIFICATION-MIB
(see the following table). All OSS clients receive the same traps in the same trap format.

Table 7: CISCO EPM-NOTIFICATION-MIB Summary

ValueTypeObject IDTrap Name

MIB version number, in the
format major version.minor
version.

Always set to 1.5.2.

SnmpAdmin

String

1.3.6.1.4.1.9.9.311.1.1.2.1.2cenAlarmVersion

Time when the alarm was
raised.

Timestamp1.3.6.1.4.1.9.9.311.
1.1.2.1.3

cenAlarmTimestamp

Alarms persist over time and
their fields can change values.
The updated time indicates the
last time a field changed and
this alarm updated.

Timestamp1.3.6.1.4.1.9.9.311.1.1.2.1.4cenAlarmUpdatedTime stamp

Serial number that uniquely
identifies each alarm.

SnmpAdmin

String

1.3.6.1.4.1.9.9.311.1.1.2.1.5cenAlarmInstanceID

Alarm status:

• 0—Not acknowledged

• 1—Acknowledged

Integer321.3.6.1.4.1.9.9.311.1.1.2.1.6cenAlarmStatus

Alarm status definition, in the
format integer,string:

• 0,Not acknowledged

• 1,Acknowledged

SnmpAdmin

String

1.3.6.1.4.1.9.9.311.1.1.2.1.7cenAlarmStatusDefinition

Not used.Integer1.3.6.1.4.1.9.9.311.1.1.2.1.8cenAlarmType
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ValueTypeObject IDTrap Name

Alarm category:

• 0—Unknown

• 100—Raw alarm

• 101—Root cause alarm

• 102—Service alarm

Integer321.3.6.1.4.1.9.9.311.1.1.2.1.9cenAlarmCategory

Alarm category definition, in
the format integer,string:

• 0,Unknown

• 100,Raw alarm

• 101,Root cause alarm

• 102,Service alarm

SnmpAdmin1.3.6.1.4.1.9.9.311.1.1.2.1.10cenAlarmCategory Definition

Alarm server address type.
Always set to IPv4.

InetAddress

Type

1.3.6.1.4.1.9.9.311.1.1.2.1.11cenAlarmServer AddressType

IP address of the application
that sent the alarm.

InetAddress1.3.6.1.4.1.9.9.311.1.1.2.1.12cenAlarmServerAddress

ID sent from the application to
Prime Central Fault
Management.

SnmpAdmin

String

1.3.6.1.4.1.9.9.311.1.1.2.1.13cenAlarmManagedObjectClass

Not used.InetAddress

Type

1.3.6.1.4.1.9.9.311.1.1.2.1.14cenAlarmManaged
ObjectAddressType

IP address of the application on
which the alarm occurred.

InetAddress1.3.6.1.4.1.9.9.311.1.1.2.1.15cenAlarmManaged
ObjectAddress

Event message text.OctetString1.3.6.1.4.1.9.9.311.1.1.2.1.16cenAlarmDescription

Integer that corresponds to the
alarm severity:

• 0—Clear.

• 1—Intermediate.

• 2—Warning.

• 3—Minor.

• 4—Major.

• 5—Critical.

Integer321.3.6.1.4.1.9.9.311.1.1.2.1.17cenAlarmSeverity
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ValueTypeObject IDTrap Name

String representation of the
alarm severity, in the format
number,description; for
example:

5,Critical

OctetString1.3.6.1.4.1.9.9.311.1.1.2.1.18cenAlarmSeverity Definition

Not used.Integer321.3.6.1.4.1.9.9.311.1.1.2.1.19cenAlarmTriageValue

Not used.OctetString1.3.6.1.4.1.9.9.311.1.1.2.1.20cenEventIDList

Alarm or event name; for
example:

• Vm Powered Off

• Host Connection Lost

SnmpAdmin

String

1.3.6.1.4.1.9.9.311.1.1.2.1.21cenUserMessage1

Service impacted by the alarm.SnmpAdmin

String

1.3.6.1.4.1.9.9.311.1.1.2.1.22cenUserMessage2

Not used.SnmpAdmin

String

1.3.6.1.4.1.9.9.311.1.1.2.1.23cenUserMessage3

Always set to alert.Integer1.3.6.1.4.1.9.9.311.1.1.2.1.24cenAlarmMode

Numerical ID of the service.Unsigned321.3.6.1.4.1.9.9.311.1.1.2.1.25cenPartitionNumber

Service type.SnmpAdmin
String

1.3.6.1.4.1.9.9.311.1.1.2.1.26cenPartitionName

Name of the customer that is
impacted by the alarm.

SnmpAdmin
String

1.3.6.1.4.1.9.9.311.1.1.2.1.27cenCustomerIdentification

ID of the customer that is
impacted by the alarm.

SnmpAdmin
String

1.3.6.1.4.1.9.9.311.1.1.2.1.28cenCustomerRevision

Not used.SnmpAdmin

String

1.3.6.1.4.1.9.9.311.1.1.2.1.29cenAlertID

Gateways and DSAs Used with Prime Central
The Prime Central base application includes two application probes and one Tier 1 SNMP gateway for
connection to a third-party OSS.

Prime Central requires a license to connect to and interoperate with other Cisco and third-party systems or
components. The following restrictions apply:

• Prime Central Tier 1 and Tier 2 gateways may not be used to connect Prime Central to third-party systems,
such as third-party trouble ticketing systems, except through a separately purchased license.
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• Prime Central Tier 1 and Tier 3 data source adaptor (DSA) instances may only be used to connect to
other Cisco applications or components embedded within Cisco applications, and in addition only if
through a separately purchased license.

• Prime Central may not be integrated with an OSS system using an MTOSI interface except through a
separately purchased license.

• Prime Central may not be integrated with Cisco applications except through a separately purchased
license.

The following table lists the Tier 1 and Tier 2 gateways and the Tier 1 and Tier 3 DSAs that are available for
use with Prime Central through a separately purchased license. For more information on Tier 1 gateways, see
the IBM Tivoli Netcool OMNIbus Reference Guides.

Table 8: Gateways and DSAs Used with Prime Central

DescriptionGateway or DSA Name

Tier 1 Gateways

The Gateway for SNMPWriter forwards Netcool alerts as Simple Network
Management Protocol (SNMP) traps to an SNMP reader, such as the IBM
Tivoli Netcool/OMNIbus SNMP probe. This allows Tivoli
Netcool/OMNIbus to generate traps that are forwarded to another
management platform such as SunNet Manager or HP Network Node
Manager.

The Gateway for SNMP Writer supports SNMP versions 1, 2, and 3.

For more information, see the IBMTivoli Netcool/OMNIbus SNMPWriter
Gateway Reference Guide.

Gateway for SNMP writer

The Gateway for Socket Writer uses a TCP connection to forward alerts.
Any program that listens to that socket receives the alerts.

For more information, see the IBMTivoli Netcool/OMNIbus SocketWriter
Gateway Reference Guide.

Gateway for socket writer

The Gateway for Flat File Writer is a unidirectional gateway that reads
alerts from the Netcool/OMNIbus object server, and writes the details to a
flat file. The gateway can receive insert, update, and delete notification
information from multiple tables within the object server.

For more information, see the IBM Tivoli Netcool/OMNIbus Flat File
Gateway Reference Guide.

Gateway for flat file writer

The Gateway for ODBC uses a set of Open Database Connectivity (ODBC)
libraries and drivers to enable data transfer between the Netcool/OMNIbus
object server and Sybase, Microsoft SQL Server, Informix, DB2, and
MySQL databases.

For more information, see the IBM Tivoli Netcool/OMNIbus Gateway for
ODBC Reference Guide.

Gateway for ODBC

Managing Faults
41

Managing Faults
Gateways and DSAs Used with Prime Central

http://www-01.ibm.com/support/knowledgecenter/SSSHTQ/omnibus/gateways/common/Gateways.html?lang=en
https://www.ibm.com/support/knowledgecenter/en/SSSHTQ/omnibus/gateways/snmpgw/wip/concept/snmpgw_intro.html
https://www.ibm.com/support/knowledgecenter/en/SSSHTQ/omnibus/gateways/snmpgw/wip/concept/snmpgw_intro.html
https://www.ibm.com/support/knowledgecenter/en/SSSHTQ/omnibus/gateways/socketjavagw/wip/concept/socketjavagw_instl_cnfgr_gateway.html
https://www.ibm.com/support/knowledgecenter/en/SSSHTQ/omnibus/gateways/socketjavagw/wip/concept/socketjavagw_instl_cnfgr_gateway.html
https://www.ibm.com/support/knowledgecenter/en/SSSHTQ/omnibus/gateways/flatfilegw/wip/concept/flatfilegw_intro.html
https://www.ibm.com/support/knowledgecenter/en/SSSHTQ/omnibus/gateways/flatfilegw/wip/concept/flatfilegw_intro.html
https://www.ibm.com/support/knowledgecenter/en/SSSHTQ/omnibus/gateways/xmlintegration/wip/concept/xmlgw_intro.html
https://www.ibm.com/support/knowledgecenter/en/SSSHTQ/omnibus/gateways/xmlintegration/wip/concept/xmlgw_intro.html


DescriptionGateway or DSA Name

The Gateway for Message Bus receives Netcool events from the object
server, uses a transformer module to transform them to an XML format that
can be understood by a destination application, and uses a transport module
to send the transformed events to the application.

For more information, see the IBM Tivoli Netcool/OMNIbus Gateway for
Message Bus Reference Guide.

Gateway for message bus
(XML/ESB)

The Gateway for JDBC uses the standard Java Database Connectivity
(JDBC) API to exchange alerts between Netcool/OMNIbus object servers
and external databases. It communicates with the supported databases using
Java Type 4 JDBC drivers supplied by the database vendors.

The Gateway for JDBC can be used as a replacement for the Tivoli
Netcool/OMNIbus Gateway for ODBC and the Tivoli Netcool/OMNIbus
Gateway for Oracle.

For more information, see the IBM Tivoli Netcool/OMNIbus Gateway for
JDBC Reference Guide.

Gateway for JDBC

The Gateway for Oracle writes selected alert details to Oracle databases.

The gateway writes to three Oracle database tables (status, journal, and
details) to record all transactions that occur within alerts selected by an
object server reader.

For more information, see the IBM Tivoli Netcool/OMNIbus Gateway for
Oracle Reference Guide.

Gateway for Oracle

Tier 2 Gateways

The Gateway for HP OpenView Service Center is a fully functional
bidirectional gateway.

Alerts forwarded from the object server go through the gateway to form HP
Service Center/ServiceManager incident management tickets. Both systems
work together to create and update alerts and tickets.

For more information, see the IBM Tivoli Netcool/OMNIbus Gateway for
HP OpenView Service Center/Service Manager Reference Guide.

Gateway for HP OpenView
Service Center

TheGateway for RemedyARS is a help desk system that operates on UNIX
platforms. The gateway converts alerts into Remedy help desk trouble
tickets. Trouble tickets are updated according to a predefined mapping
throughout the lifetime of the alert.

For more information, see the IBM Tivoli Netcool/OMNIbus Gateway for
Remedy ARS Reference Guide.

Gateway for Remedy ARS
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DescriptionGateway or DSA Name

The Gateway for TSRM provides bidirectional communication between
Netcool/OMNIbus and Tivoli Service Request Manager (TSRM).

The gateway supports TSRM version 7.1 (Fix Pack 4 and later), TSRM
version 7.2, and IBM Maximo Base Services (MBS) version 7.1.1.5.

For more information, see the IBM Tivoli Netcool/OMNIbus Gateway for
TSRM Reference Guide.

Gateway for TSRM

Tier 1 DSAs

The LDAP DSA is used to access information stored in an LDAP server.

This type of DSA is read-only. You cannot use Netcool/Impact to insert
new LDAP data into the server data store. The LDAP DSA is built in and
does not require additional installation or configuration.

For more information, see the IBM Tivoli Netcool/Impact DSA Reference
Guide.

LDAP DSA

The socket DSA provides an interface between Tivoli Netcool/Impact and
a socket server.

For more information, see the IBM Tivoli Netcool/Impact DSA Reference
Guide.

Socket DSA

The XML DSA reads and extracts data from any well-formed XML
document.

For more information, see the IBM Tivoli Netcool/Impact DSA Reference
Guide.

XML DSA

For more information, see the IBM Tivoli Netcool/Impact DSA Reference
Guide.

DB2 DSA

Flat File DSA

Generic SQL DSA

HSQLDB DSA

Informix DSA

MS-SQL Server DSA

MySQL DSA

ObjectServer DSA

ODBC DSA

Oracle DSA

PostgreSQL DSA

Sybase DSA
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DescriptionGateway or DSA Name

Tier 3 DSAs

The JMS DSA sends and receives Java Message Service (JMS) messages
from within a policy.

The JMS DSA is installed automatically when you install Netcool/Impact.

For more information, see the IBM Tivoli Netcool/Impact DSA Reference
Guide.

JMS DSA

The web services DSA is a direct-mode DSA that Netcool/Impact
automatically loads during application runtime.

You do not have to start or stop this DSA independently of the application.
The web services DSA is installed with Netcool/Impact and does not require
additional installation or configuration.

The web services DSA is compatible with its older versions in
Netcool/Impact 3.x and 4.x. This means that your old IPL policies developed
on Netcool/Impact 3.x and 4.x will continue to run without modification in
the current version.

The web services DSA provides support for WSDL version 1.1 and 2.0,
and SOAP version 1.1.

For more information, see the IBM Tivoli Netcool/Impact DSA Reference
Guide.

Web services DSA
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